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1. | ntr oduct

| 0N

SiteExecutive empowers non-technical usersto create, manage and deliver content without
the need to rely on technical personnel. Its straightforward, easy-to-read interface simplifies
every aspect of web publishing and site management. With SiteExecutive, users can publish

information to the live website in minutes.

This guide details the benefits of using SiteExecutive to manage your web content, and it lists
thes o f t wsysteen @rsl browser configuration requirements. For information on creating
and managing content in SiteExecutive, see theEnd User Guie.

SITE Eyecutire”

SAl SYSTEMS ALLIANCE, INC

u Username
u Password
LOGIN

SiteExecutive 20T Getting Started Guide

Welcome to SiteExecutive!
SiteExecutive empowers non-technical
users to create, manage and deliver
content without the need to rely on
technical personnel.

Set Your Permissions
Administrators can assign Read, Write,
and Administrative permissions to any
object in the system.

Multi-Server Support

This allows separation and independent
clustering of authoring and rendering
Servers.
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1.1 Understanding SiteExecutive Features

1.1.1 UserDesigned Interface

SiteExecutivedelivers an easy and familiar experience for content managers To that
end, SiteExecutiveprovides:

1

Browser -based management : No applications to install or learn d no
investment in workstation Total Cost of Ownership (TCO).

Exceptionally easy learning p ath: Typical training sessions take no more
than a day.

Easy creation of site layout and h ierarchy : Complete visual presentations
of site hierarchy and page previews provide constant feedback to the
content manager.

Rapid creation, editing, and publishing of p  ages: Content managers can
publish content with unprecedented ease.

1.1.2 Enterprise Management

SiteExecutiveprovides the tools and features that allow content ma nagers to plan,
execute, and maintain their web properties effectively and efficiently.

1

Multiple sites within one database/SiteExecutive instance: A site
administrator can maintain multiple sites (e.g. a public-facing Website and
an intranet) from one SiteExecutive instance that is, one database andone
SiteExecutive interface).

Dynamic, self-maintaining links and navigation : All internal links within
SiteExecutiveare dynamic. Links to pages,documents, graphics, and media
are calculated in reaktime. Files may be renamed or moved without
breaking any references.

Link validation : The Link Validation tool may be scheduled to run at a
certain time or can be run manually to ensure that all links are still valid.

Extended Find and Replace : This tool allows an administrator to perform
an extended find and replace of content or text throughout all or individual
sites in SiteExecutive.

SiteExecutive 20T Getting Started Guide Page?2



1 Read, Write, and Administrative privileges for all SiteExecutive items :
Administrators can assign Read, Write, and Administraive permissions to
any object in the system.

1 Complete workflow with real-time e-mail notification : Workflow can be
applied to all locations within the site structure and is based upon the users
and groups established in the system. Each step of the approval process is
executed through emails with links back to the content in question within
the administrative interface.

1 Comprehensive audit logs for all key functions : Each edit, update, and
publishing event is logged in the audit system.

1 Unlimited versions available for review/ recall with complete logs: Each
published page replaces the current live page and all previous pages are
stored in the database for future review or re-publication. There is no limit
(other than the database size) to the number of previous versions that can
be stored.

9 External security model for controlled access The system provides an
easy-to-use interface to restrict external visitor access.

1 Process Monitor : This tool tracksall running processes in SiteExecutive. By
default, the link validation, search indexing,and repair processes are linked
for monitoring. Additional processes can be monitored if registered via a
module.

1.1.3 Enterprise Implementation and Extensibility

1 Application Programming Interface  : Enterprise applications can be
integrated for extensibility through our robust application programming
interfaces (APISs).

i Centralized control of the look and feel of the site: Because information
is stored in a central server and database, all changes made by one user are
vi si ble to all user s. Content does not

1 Simple installation path: SiteExecutivecan be quickly installed and run on
a configured server.

1 Rapid implementation : With professional direction and/or an experienced
web master, an organization can have a fully functioning SiteExecutive
based site up and useable within a short amount of time.

SiteExecutive 20T Getting Started Guide Page3



1 Scalable with affordable hardware : SiteExecutiveruns well on basic
hardware. Although larger sites will require appropriate infrastructure, basic
sites can be deployed on affordable servers.

1.2 SiteExecutiveSystem Components

SiteExecutivefunctionality is driven by the following major compon ents:

Database

==  Final Pages
System -—

Code Base

SiteExecutive

» Core Code : Sy T ——
i - : | vawo e Rendering
Classes - | —" SRR - Engine
P v LX) ¥
EVOIVE -
T | osss MG
* Standard e lm~ =

e Custom

1 Database System: The database, which is XMtbased, contains all directly
editable data, references any binary objects (uploaded images, files, etc.), and
drives all functions.

1 Code Base: The compact core functional code baseconsists of application server
scripts, DLLOSs, and Java code. Only one <coo
multi-instance configurations easy to manage.

9 SiteExecutive Modules : Modules are extensions of the core code. SiteExecutive
includes a number of core modules, but additional modules can be coded and
uploaded into the program as well. There are four general types of modules:

o Core Interface : These modules drive the administrative interface and are
part of the SiteExecutivesystem. Core interfaces ae written by Systems
Alliance.

SiteExecutive 20T Getting Started Guide Page4



o System Information : These modules provide content editors and
managers access to Sit&xecutiveinformation and content. Tools such as
the Site Map, Search Interface, and various navigation tools are included
in this category. Many system information modules are included with the
tool and the Application Programming Interface allows further access to
this information for customization.

o Object Integration : These modules typically assist with complex tasks
that often require exte nsive surrounding code.

o Enterprise Integration: This is the primary function of the Application
Programming Interface. It allows for the design and development of
complete Web-based applications. Content managers can integrate these
modules without technic al training.

I Multi -Server Support : SiteExecutivesupports clustered environments natively.
This allows separation and independent clustering of authoring and rendering
servers and provides an internal messaging system that keeps all servers in the
cluster synchronized whenever a change is made on anyone of them.

1 Rendering Engine : The rendering engine takes the core Sitdexecutiveoutput and
valid output from any custom modules and creates the final output format in
real-time. Current rendering defaults to HTML. SiteExecutive can render output in
a wide range of XML-based formats.

9 Final Output : While the default is HTML, final output can be tailored to any
required form.

1.3 SiteExecutive Interface Concepts

1.3.1 Components of the Administrative Interface
The Administrative Interface provides the core content management functions. It
uses easyto-recognize and familiar icons.

Depending on the installed options and administrative privileges for content
managers, various functions may or may not be available in the interface. When
these functions are disabled, theyappear6 gr ayed & out .

The primary components of the Administrative Interface are illustrated below :

SiteExecutive 20T Getting Started Guide Page5



SE  siteExecutive 2017 Logged in 3= admin | Main | Logout

[=] site Tree o4 || Home Q search...

® @ www.se-shaffer.com | [Desktop | Link Validation Search Index _Utilities _Properties Audit Log)

System Options: -

“ Q@ D Y

Permissions Create Site Extended Find & Meta Tag
Replace Administration

User Options:

Site Explorer
Change Your Who's Logged In
Password
Featured Content:
E} @ Tab Display Area
Suggested Featured Managed Featured
Content Content
.Di:linnary Options:
g ‘

Manage User Default Options
Dictionaries

Utilities:

G ) o) E

@ Templates/Style Sheets R Gt e e s Cter Object Viewer

& Modules/Applications
I —

L. B B N. : ROOT 1D: 0
[“%» Administration ame
L Created By: admin Last Modified By: admin <

About | Help © 2017 Systems Alliance, Inc

See theEnd User Guiddor information on how to navigate through SiteExecutive
and use the various functionalities of the interface.

1.3.2 Core Modules

The module interface of SiteExecutivemakes it a flexible and powerful tool for
advanced Web management. It enables users to insert complex output and tools
onto a page without having to learn Web -based application languages. The
modular design also makes it possible to reconfigure SiteExecutive to provide
varying levels of functionality.

The system contains a core set of modules that drive general content management
and navigation. Some of these modules include:

Navigation Module: This module creates a context-sensitive menu of links for
navigating throughout your site or within specific folders on your site.

Object Inclusion Module: This module allows content editors to embed objects
uploaded to or created within SiteExecutive onto a page or template.
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1.3.3 Page Management Features

SiteExecutivemakes it easy to control a wide range of security and
workflow/approval processes.

Login/Registration : The Login/Registration module allows for rapid assignment of
external password access to secured areasn the site. The module makes it
possible to create any combination of login pages for multiple areas of a
SiteExecutiveWebsite.

Permissions: SiteExecutivehas an internal security system that allows
administrators to control access to specific areas andfunctionality within
SiteExecutive for users and groups of users.

Workflow/Approval : The Workflow system can be utilized to route content
created by content editors to individual users or groups for review prior to
publication. All approval processes are &ecuted via email notifications and every
approval and change is tracked inthe audit log system.

Versioning : Aspages are published, their previous versions are archived for review
and recall. There is no limit to the number of previous versions that can be stored.

Searching: The Search Application allows SiteExecutive users to search throughout
the instance for content. All objects are indexed either automatically upon
publishing or when search indexing is run on the site.

Audit Trails : Almost all actions at the site, folder, page, or object level are recorded
for review.

Dynamic Calculations : All references to objects within a SiteExecutiveinstance are
calculated in real-time, making broken links less likely.

SiteExecutive 20T Getting Started Guide Page7



2Facilitating User Prc

Creating and managing content of any scale is inevitably complex. The goal of SiteExecutive
is to simplify the process for the typical content manager.

Content managers should be able to easily manage general content, create relationships,
include modules, a well asupload and use images and documents. With SiteExecutive this
can be accomplished without the need for technical support or HTML proficiency.

2.1 Core Content Management Skills

SiteExecutive enables basic content managers to perform the following core tasks with
ease

1 Creating folders and pages

1 Editing and saving page content

9 Approving and publishing page content
1 Uploading files and images

1 Inserting images

1

Inserting links and page anchors

2.1.1 Additional Skills

Some of the more advanced skills SiteExecutive provides for content managers are
Creating advanced dynamic navigation

Inserting tables

Using modules

Editing page properties

Changing templates at the page level

Renaming, moving and copying objects

Replacing content

Replacing files/images

=A =/ =4 =4 =4 =4 4 -4 =9

Deleting objects

SiteExecutive 20T Getting Started Guide Page8
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Exporting files

Accessing and sending the URL of a binary file
Archiving and recalling pages

Purging archives

2.2 SiteExecutiveBenefits

The following table outlines the primary challenges typically encountered by a small
business university, or corporation when managing an internet or intranet project. In
addition, it describes how SiteExecutivemitigate s these challenges.

Issue

Rapid Implementation

Common Look and Feel

Shared Content
Management

Easy Management of
Links and Content

Revision Control

Site Executive Solution

Large websites can take months to assemble and review.
SiteExecutivereduces the time frame to accomplish this task.
Content can be viewed as it is approved and published.

If sites are built on manual templates that are physically part
of a page, it is nearly impossible to maintain design
standards. SiteExecutiveensures that all pages are based on
a set of pre-configured templates with applied styles. The
content managers cannot change these templates.

Managing content on an Internet or intranet system may
involve dozens or hundreds of people. Coordinating these
efforts in a traditional web development system is arduous.
SiteExecutiveallows any number of users to create, edit,
approve, and maintain content.

Large websites may have thousands of links within the site,
which are frequently hard to maintain. SiteExecutive
manages links dynamically by checking them as they are
requested.

SiteExecutiveallows for the availability of multiple versions
of a page. This enables edit and approval of a page without
affecting published content.

SiteExecutive 20T Getting Started Guide
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Issue Site Executive Solution

Access to viewing and editing pages is controlled through a
flexible users/groups interface. Specific areas within the web

Internal/External Security structure can be configured to require login credentials from
site visitors. Additionally, SiteExecutive supports the
integration of external security models.

Pages can be assigned a cascading set of workflow stps
Workflow that require the content to be approved before it is
published.

SiteExecutiveenhances the workflow and reduces the time required to create and
maintain a Website.

SiteExecutive 20T Getting Started Guide Page 10



3Computer Confilgurati c

The Administrative Interface of SiteExecutiverequires that computers meet specific
requirements. Configuration settings and software on computers should be checked prior to
the use of SiteExecutive These settings are required for the administrative components of
SiteExecutiveand do not impact the viewing of published pages.

3.1 Client Configuration Settings

Windows users should ensure the following standards are met on their computers:
1 The computer has a stable operating system installed:
0 Windows XP, Vista, 7, 8or higher
0 Mac OSX 10.60r higher
I Thesystem resolution is setto 1024x768 or higher at millions of colors.

1 The computer has a supported web browser installed. See the next section for
more information on which browsers SiteExecutive supports.

1 The operating system is up to date (verified through Windows Update or Apple
Software Update).

3.1.1 Operating System/Hardware

SiteExecutiverequires the availability of a stable installation of one of the supported
operating systems named at the beginning of this section. The system should be
free from frequent crashes or system errors.

To deter mi ne Windowsmgrsioh er 0 s

1. On the Windows desktop, select the Start menu.
2. Right-click on Computer .
3. SelectProperties .

The System Properties dialog box will appear.

SiteExecutive 20T Getting Started Guide Pagell



. . ;H;, + Control Panel » System and Security » System -

Control Panel Home . .. .
View basic information about your computer

&) Device Manager Windows edition

) Remote settings Windows 7 Professianal

'@' System protection Copyright © 2009 Microsoft Corporation. All rights reserved.
'@' Advanced system settings Service Pack1

Get more features with a new edition of Windows 7

System
Manufacturer: Dell
Model: Latitude E6530
Rating: mwindcws Experience Index
Processor: Intel(R) Core(TH) i5-3210M CPU @ 2,50GHz 2,50 GHz
Installed memory (RAM):  4.00 GB (3.88 GB usable)
System type: 64-bit Operating System
Pen and Touch: Mo Pen or Touch Input is available for this Display
Dell support
Website: Online support
FamooE Computer name, demain, and workgroup settings |
Action Center Computer name: Balt-002719 r@Change settings
Windows Update Full computer name: Balt-002719.5YSALLLcom
Performance Information and Computer description:
Tzals Domain: SYSALLLcom
Thisdialogbox al |l ows users to determine thae compl

amount of installed memory.

If the RAM is shown in KB instead of MB, users can divide the RAM number by
1024. If the result is not a whole number, users should round up to the nearest
whole number.

A minimum of 64MB of RAM is recommended (128MB is preferred).
To deter mi ne MacO8 Xyensioner 4 s

1. Drop down the Apple % menu.
2. SelectAbout This Mac.

The About This Mac dialog box will appear. Verify that your computer has a
supported version of Mac OS X installed and that it has the requisite amount of
RAM.

SiteExecutive 20T Getting Started Guide Page 12



3.1.2 Monitor/Resolution Setting

This section
monitor/resolution settings.

3.1.2.1 Windows XP

covers process

behind

NOTE The screens in this section will vary based on operating system and

installed software.
To check the monitor settings

1. Right-click on the Windows desktop.
2. Click Properties .

in Windows XP :

Arrange Icons By
Refresh

Save As Scheme. ..
Graphics Options
Display Modes

Mew

Properties h

The Display Properties dialog appears:

SiteExecutive 20T Getting Started Guide
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Display Properties

Themes | Deskiop | Screen Saver | Appearance | Settings |

Atheme iz a background plus a set of sounds, icons, and other elements
to help you personalize your computer with one click.

Theme:
[Vindows X odies) 3
Sample:

Active Window
Window Text

[ OK H Cancel l

3. Select the Settings tab.

The Settings tab will appear. The options here may vary based on the
differences in video card and software packages.

4. Inthe Screen area or Screen resolution , users should set the resolution to
1024x768 or higher.

SiteExecutive 20T Getting Started Guide Page 14



Display Properties

| Themes || Desktop || Screen Saver || Appearance | Settings

Drag the manitor icons to match the physical amangement of your monitars.

Display:

1. Digital Flat Panel {1024x768) on Intel{R) 82852/82855 GM/GME Grz | » |
Screen resolution Color quality
= More | [highest (32bit) |

1024 by 788 pixsls [ N N |

to this monitor

[ Identify ][Troubleshoot... ] [ Advanced

L OK J[ Cancel ] Ppply

5. Inthe Colors or Color quality , users should set the image to True Color
(32 bit) or Highest (32 bit) .

6. Click Apply or OK to confirm changes.

NOTE: Most computers support these settings. If they are not available, it is
likely that outdated or incorrect video drivers ar e installed.

3.1.2.2Windows Vista/7

NOTE The screens in this section will vary based on operating system and
installed software.

To check the monitor settings  in Windows Vista/7 :

1. Right-click on the Windows desktop.

2. Click Personalize.

SiteExecutive 20T Getting Started Guide Page 15



Wiy 3
Sort By »
Refresh

Paste
Paste Shortcut

ew 3

Es  Personalize

The Appearance and Personalization dialogue box will appear.

3. Click on the Display link on the bottom left of the dialogue box.

PP

ol i & » Control Panel » A

Control Panel Home . @
Change the visuals and sounds on your computer

Change desktop icons Click a theme to change the desktop background, window color, sounds, and screen saver all at once.

Change mouse pointers My Themes (0) -

Change your account picture
Get more themes online
Aero Themes (7)

m

e

Windows 7 Architecture Characters Landscapes Nature

Installed Themes (1)

= | -
) ] = s

Desktop Background Window Color Sounds Screen Saver
Easect Scce==Center Win7 LtBlue 1920x1200 Frost Windows Default None

SiteExecutive 20T Getting Started Guide Page 16



The Display dialog box will appear. The options here may vary based on
the differences in video card and software packages

l=]E s

- e T - At 14 &
@uyr-‘ » Control Panel » Appearance and Personalization » Display v‘6,H Search Control Panel P‘
@

Control Panel Home : A .
Make it easier to read what's on your screen
Adjust resolution You can change the size of text and other items on your screen by choosing one of these options. To
= temporarily enlarge just part of the screen, use the Magnifier tool.

) Calibrate color

Change display settings

% @ Smaller - 100% (default) Preview
Connect to a projector
Adjust ClearType text

Set custom text size (DP]) © Medium - 125%

© Larger - 150%

Apply

See also
Personalization

Devices and Printers

4. Under Adjust resolution , users should move the slider to set the resolution
to 1024x768 or higher.

5. Under Calibrate color s, users should set the image toHigh (32 bit) .

6. Click Apply to confirm changes.

NOTE Most computers support these settings. If they are not
available, it is likely that outdated or incorrect video drivers are
installed.

SiteExecutive 20T Getting Started Guide Page 17



4 . Browser Configurat.

This section outlines the browser requirements for using SiteExecutive, including the
browsers supported by SiteExecutive, configurationsettings for specific browsers for proper
SiteExecutive performance, and steps for ensuring that your browser is up to date.

4.1 Browser Version

SiteExecutive 2017 supports the following browsers:
9 Internet Explorer versions8, 9, 10, and 11

Microsoft Edge

Mozilla Firefox version 26 or higher

Google Chrome version 31.xor higher

= =_ =4 =4

Apple Safari version 5.xor higher

4.1.1Confirming Internet Explorer Version

To check the Internet Explorer browser version:
1. Start Internet Explorer.

2. Click Tools on the menu bar.

3. SelectAbout Internet Explorer

The About Internet Explorer  window will appear:

SiteExecutive 20T Getting Started Guide Page 18



-
_63 About Internet Exp-lzrer MNLA .

f/’é} Windows* Internet

. Explorer9

Version: 9.0.8112. 16421

|pdate Versions: 9.0.15 (KB2817133)
Cipher Strength: 256-bit

Product ID: 03553-997-8992671-00524

possible under the law,

© 2011 Microsoft Corporation

Warning: This computer program is protected by copyright law and
international treaties. Unauthorized reproduction or distribution of
this program, or any portion of it, may result in severe dvil and
criminal penalties, and will be prosecuted to the maximum extent

4. Confirm that the Internet Explorer version is at least8.0.

4.1.2 Confirming Firefox Version

To check the Mozilla Firefox browser version:
1. Start Mozilla Firefox.

2. Click Firefox on the menu bar.

3. SelectHelp.
4

Select About Mozilla Firefox

SiteExecutive 20T Getting Started Guide
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Firefox =

Mew Tab

B8 Mew Private Window
Edit
Find...

Save Page As...
Email Link...

= Print...
Web Developer

Full Screen
Set Up Sync...
Exit

» ﬁ Bookmarks

irefo rt Paoe

History L
" Downloads
-* Add-ons
Opticns »
Help 4 Help
' Getting Started
b Troubleshooting Information

Submit Feedback...

Restart with Add-ons Disabled...

About Firefox

The About Mozilla

Firefox window will appear:

About Mozilla Firefox

e =0

Licensing Information

Firefox

Firefox is up to date

Firefox is designed by Mozilla, a global community werking
together to keep the Web open, public and accessible to all.

Sound interesting? Get involved!

End-User Rights Privacy Policy

=marks of the Mazillz Foundation

Firefiox and the Firefox logos are trade

5. Confirm that the Mozilla Firefox version is at least 26.0.

4.1.3 Confirming Chrome Version

To check the Google Chrome browser version:
1. Start Google Chrome.
2. Click the Chrome Menu button

| 5]

-

3. SelectAbout Google Chrome from the dropdown.

A new tab opens with the Google Chrome browser information:

SiteExecutive 20T Getting Started Guide
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Chrome

History
Extensions

Settings

I Help

About

Google Chrome

A oweb browser built for speed, simplicity, and security

Get help with using Chrome Report an issue

Version 310165063 m
Google Chrome is up to date,

Google Chrome
Copyright 2013 Google Inc. All rights reserved.

Google Chrome is made possible by the Chromium open source project and other open source saftware,

Google Chrome Terms of Service

4. Verify that your version of Google Chrome is at least 31.0.

4.1.4 Confirming Safari Version

To check the Apple Safari browser version in Mac OS X

1. Start Apple Safari.

2. At the top of your screen, click on Safari.

3. Choose About Safari from the dropdown menu.

A menu appears with the Safari version listed. Verify that your version of Safari

is at least 5.0.

4.2 Browser Updates

This section covers theprocess for updating your browser. We recommend setting your
browser to update automatically to ensure consistent performance.
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4.2.1Internet Explorer Updates

To update Internet Explorer :
1. Start Internet Explorer.
2. Click on the Tools menu.

3. SelectView Downl oads.

o vr K
] Print k
File 3
Zoom (100%:) ¥
Safety k
View downloads Ctrl+J

Manage add-ons
I F12 developer tools

Go to pinned sites

Internet options

About Internet Explorer

4. From the View and Track Your Downloads page, perform a scan for updates
and follow the instructions to complete all critical updates.

4.2.2 Firefox Updates

To update Mozilla Firefox , follow the stepslisted in Section 4.1.2: Confirming
Firefox Ver sion. The browser will automatically check for updates.

4.2.3 Chrome Updates

To update Google Chrome, follow the steps listed in Section 4.1.3: Confirming
Chrome Version. Additionally, the Chrome menu button will change color if an
update is available.
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4.2.4 Safari Updates

Updates for Apple Safari can be installed via the Apple Support Center, the Apple
Software Update utility, or the Mac App Store (as of Mac OS X version Mountain

Lion).

4.3 Browser Settings

This section details the specific browsersettings that must be configured for each
browser in order for SiteExecutive to perform optimally.

NOTE: Adobe Flash Player is required for the multi

Modul es/Applications explorer

-file uploader utility in
SiteExecutive , and for displaying the Results tab for Advanced Forms in the
. If you do not have Flash installed, then the only

other method for uploading multiple files at once is the Zip Extraction tool. See the

End User Guide for more information.

4.3.1Internet Explorer Settings

4.3.1.1Temporary Internet Files

To change the settings in Internet Explorer:

1. Start Internet Explorer.
2. Click on the Tools menu.

3. Selectinternet Options.

Print

File

Zoom (100%)
Safety

Add site to Start menu
View downloads
Manage add-ons

F12 developer tools

Go to pinned sites

Internet options

About Internet Explorer

* v w v

Ctrl+J

SiteExecutive 20T Getting Started Guide
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The Internet Options dialog box will appear.

General tab.

General |Se-::|.1rit:5.I I Privacy I Content I Connections | Programs I Advam:ed|

Home page

To create home page tabs, type each address on its own line,

[-u
B Wiga.microsoft.com/fwlink/p/7Linkld=255141 -

-

l Use current H Use default H Use new tab

Startup
() Start with tabs from the last session
@ Start with home page

Tabs

Change how webpages are displayed in tabs.

Browsing history

Delete temporary files, history, cookies, saved passwords, and web
form information.

[] Delete brawsing history on exit

[ Delete... ” Settings ]

Appearance
Colors H Languages ” Fonts H Accessibility l

The Settings window will appear.

Temporary Internet Files | History I Caches and databases

Internet Explorer stores copies of webpages, images, and media
for faster viewing later.

Check for newer versions of stored pages:
(@ Every time I visit the webpage
(7 Every time I start Internet Explorer
() Automatically
() Mewver
Dizk space to use (8-1024ME) 250
(Recommended: 50-250MB)

Current location:

Ci\Users'blemke \AppData'Local\Microsoft\Windows Temporary
Internet Files,

[ Mave folder... ][ View objects ][ View files ]

SiteExecutive 20T Getting Started Guide
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5. Select the radio button for Every time | visit the webpage.
6. Click OK to exit the Settings window.

7. Click OK to exit the Internet Options dialog box.

4.3.1.2Trusted Sites

Your organi zat i omghtsequireSitettrecukive psers to adg the
SiteExecutive authoring URL to their Trusted Sites list in Internet Explorer.

To add the content management system to the trusted sites:

1. Start Internet Explorer.
2. Click on the Tools menu.

3. Selectinternet Options.

Print »
File »
Zoom (100%) 3
Safety 2

Add site to Start menu
View downloads Ctrl+)
Manage add-ons

v F12 developer tools

Go to pinned sites

Internet options

About Internet Explorer

The Internet Options dialog will appear.

4. Select the Security tab.

SiteExecutive 20T Getting Started Guide Page 25



| GeneraIPri\faqI I Content | Connections I Programs I Adwvanced

Select & zone to view or change security settings.

@ & v O

Internet  Localintranet PEEsEE=] — Restricted
sites
Trusted sites
J This zone contains websites that you

trust not to damage your computer or
your files,

Security level for this zone
Allowed levels for this zone: Al

Medium
- Prompts before downloading potentially unsafe

. content

- Unsigned ActiveX controls will not be downloaded

["]Enable Protected Mode {requires restarting Internet Explorer)
Custom level... Default level

Reset all zones to default level

[ ok || cancal Apply

5. Clickthe Trusted sites icon.

6. Clickthe Sites button.

e e e
J This zone contains websites that you

trust not to damage your computer ar
your files,

The Trusted sites dialog will appear:

) You can add and remove websites from this zone. All websites in
L this zone will use the zone's security settings.

Add this website to the zone:

http://wnarw.msn.com

Websites:

Remove

Require server verification (https:) for all sites in this zone
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7. Inthe field labeled Add this website to the zone |, type the authoring URL
of your SiteExecutive instance

8. Uncheck the checkbox labeled Require server verification (https:)  for all
sites in this zone .

9. ClickAdd.
10. Click Close in the Trusted sites dialog box.
11. Click OK in the Internet Options dialog box.

NOTE Pop-up blockers may affect the display of SiteExecutive
windows and functionality. Pop -up blockers may have to be turned
off.

4.3.1.3Pop-up Blocker

SiteExecutive will use popup windows extensively to display additional options
for selected functions or to prompt alerts on functionality. Blocking
SiteExecutive sites from displaying the pop-up windows will limit the
functionality of SiteExecutive to a great extent. To be able to use SiteExecutive
functionality fully, users should add the site to the Allowed Sites list of the
Pop-up Blocker . This will not change general pop-up blocker settings.

To allow SiteExecutive pop -ups in Internet Explorer 7.0+

1. Start Internet Explorer.
2. Click on the Tools menu.

3. Selectinternet Options .

Print »
File 3
Zoom (100%) 4
Safety »

Add site to Start menu
View downloads Ctrl+J
Manage add-ons

v Fl2 developer tools

Go to pinned sites

Internet options

About Internet Explorer

The Internet Options dialog box will appear.
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4. Select the Privacy tab.

General | Security | Privacy |Ccr1tent | Connections I Programs I Advanced

Settings

To set a standard privacy level instead of using custom
settings, dick the Default button.

Custom

- Advanced or imported settings

[ Sites ] [ Import ] [ Advanced ] [ Default ]
Location

Mever allow websites to request your
(& physical location
Pop-up Blacker
Turn on Pop-up Blocker
InPrivate

Disable toolbars and extensions when InPrivate Browsing starts

l oK ][ Cancel ] Apply

5. Click on the Settings button in the Pop-up Blocker section.

The Pop-up Blocker Settings dialog box will appear.
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Pop-up Blocker Settings | = ﬂ
Exceptions "
Pop-ups are cumently blocked. You can allow pop-ups from specific

; | websites by adding the site to the list below.
Address of website to allow:
Add
Allowed sites:
hitp://support dell. com/support findex aspx Fo=usdl=end... Remaove I
hitp://support.dell. com./support Aopics/global aspxsup. .
hitp/fwww dell com
http:# A dellauction com
Motfications and blocking level: I
Play a sound when a pop-up is blocked.
[¥] Show Matification bar when a pop-up is blocked.
Blocking level: I
[Medium: Block most automatic pop-ups v]
Leam more about Pop-up Blocker

6. Inthe field labeled Address of website to allow, type the authoring URL
of your SiteExecutive instance

7. Click the Add button .
8. Click Close to close the Pop-up Blocker Settings dialog box.
9. Click OK in the Internet Options dialog box.

4.3.1.4Allow Access to the Clipboard

Internet Explorer 7.0+ includes a customizable security setting that will prevent

the editor from accessing data on Windows Clipboard. While this is a

preventive security measure when turned on, when editing SiteExecutive

content in Internet Explorer 7.0+, the following message may appear

frequenty: 0 Do you want to allow this Webpage ac

To allow SiteExecutive editor to access the Windows Clipboard, once the site is
added as a O0Trusted Sited zone, programmat
allowed for sites in the Trusted Sites zane.

Information on how to add the site to the Trusted Sites can be found in Trusted
Sites section of this user guide.
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To allow programmatic clipboard access for trusted sites:

1. Start Internet Explorer.
2. Click on the Tools menu.

3. Selectinternet Options .

Print »
File 3
Zoom (100%:) k
Safety »

Add site to Start menu
View downloads Ctrl+J
Manage add-ons

v F12 developer tools

Go to pinned sites

Internet options

About Internet Explorer

The Internet Options dialog box will appear.
4. Select the Security tab.
5. Click Trusted sites .

6. Click on the Custom level button in the Security level for this zone
section.
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General | Security |Priuaq-' | Content | Connections I Programs I Advanced

Select a zone to view or change security settings.

@ & v O

Internet  Local intranet  Trusted sites  Restricted
sites

e o
J This zone contains websites that you

trust not to damage your computer or
your files,

Security level for this zone
Allowed levels for this zone: Al

Medium
- Prompts before downloading potentially unsafe

c— content

- Unsigned ActiveX controls will not be downloaded

[]Enable Protected Mode {requires restarting Internet Explorer)
Custom level... Default level

Reset all zones to default level

The Security Settings 0 Trusted Sites Zone dialog box will appear.

In the Security Settings 0 Trusted Sites Zonedialog box, scroll down to

Scripting and select Enable for the Allow Programmatic clipboard

accessoption.

Settings
& | Saripting -
& | Active sripting
(7) Disable
@ Enable
() Prompt
| Allow Programmatic dipboard access h
(7) Disable
i@ Enable _
() Prompt
'_E_-._”I Allow status bar updates via script
(7) Disable
@ Enable
'_E_-._”I Allow websites to prompt for information using scripted l.n‘:.lim:l:l:I
(7) Disable
@ Enable il
(= Enshls ¥EC Albar
4| I | b

*Takes effect after you restart your computer

SiteExecutive 20T Getting Started Guide
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8. Click OK in the Security Settings & Trusted Sites Zone dialog box.

9. Click Yesin the confirmation message.

10. Click OK on the Internet Options dialog box.

4.3.1.5 Disable Compatibility View

Compatibility View is a setting in Internet Explorer that causes the browser to
load pages in an outdated manner. This setting can cause issues with using

SiteExecutive and rendering $ieExecutive websites.

To disable Compatibility View:

1. Open Internet Explorer.

2. Drop down the Tools menu.

ml| L | http:/fwww.msn.com/

File Edit View Favorites Help

Outlog

m

NEW
cele

Decem

3. Verify that Compatibility View

SiteExecutive 20T Getting Started Guide

Delete browsing history...
InPrivate Browsing
Tracking Protection...
ActiveX Filtering

Fix connection problems...

Reopen last browsing sessicn

Add site to Start menu

View downloads
Pop-up Blocker
SmartScreen Filter

Manage add-ons
Compatibility View
Compatibility View settings
Subscribe to this feed...

Feed discovery

Windows Update
F12 developer tools

Lynec Click to Call
OneMote Linked Motes
Send to OneMote

Eleg This in Windows Live Writer

Internet options

Ctrl+Shift+Del
Ctrl+Shift+P

Ctrl+)

is not highlighted or checked.
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4.3.2Mozilla Firefox Settings

4.3.2.1Browser Cache

To change the browser cache settin gs in Mozilla Firefox:

1. Start Mozilla Firefox.

2. Type about:config in the address bar.If a confirmation dialog appears,
clickl 61 1 be careful, I promi se!

The about:config menu appears.
Type cache in the Search field.
Change the browser.cache.check_doc_frequency value to 1.

Change the browser.cache.disk.enable value to false.

o 0 > w

Change the browser.cache.memory.enable value to false.

Search: cache

Preference Mame *  Status Type Yalue
browser.cache.check_doc_frequency userset  integer 1
browser.cache.compression_level default integer 0
browser.cache.disk.capacity user set  integer 358400
browser.cache.disk.enable userset  boolean false
browser.cache.disk.max_entry_size default integer 51200
browser.cache.disk.smart_size.enabled default boolean  true
browser.cache.disk.smart_size.first_run user set  boolean false
browser.cache.disk.smart_size.use_old_max user set boolean false
browser.cache.disk.smart_size_cached_value user set integer 358400
browser.cache.disk_cache_ss| default boolean  true
browser.cache.memory.enable user set  boolean false

7. Close the browser.

4.3.2.2Pop-up Blocker

SiteExecutive will use popup windows extensively to display additional options
for selected functions or to prompt alerts on functionality. Blocking
SiteExecutive sites from displaying the pop-up windows will limit the
functionality of SiteExecutive to a great extent.
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In order to use SiteExecutie 86 s f ul | ,{sers should add thdiri t vy
SiteExecutive authoring siteto the Allowed Sites list of the Pop-up Blocker.

This will not change general pop-up blocker settings.

To allow SiteExecutive pop-ups in Firefox :

1. Start Firefox.
2. Click on the Tools menu.
3. SelectOptions.
The Options dialog box will appear.

4. Clickthe Content tab.

5. To the right of the Block pop -up windows option, click the Exceptions

button.

Options

BE)

O &= & &

General Tabs Content  Applications  Privacy

N )
; KLER
:"_,1‘. \ i L@
== y vird”

Security Sync  Advanced

Block pop-up windows

Fonts & Celors

Exceptions...

Default font: | Times New Roman '] Size: [16 'l l&dvanced...]
Languages
Cheose your preferred language for displaying pages

| ok

J[ T ][ Help ]

The Allowed Sites 6 Popups dialog

SiteExecutive 20T Getting Started Guide

box will appear:
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6. Type the URLof your SiteExecutive authoring instance into the field labeled
Address of website .

7. Click the Allow button.
8. Click Close on the Allowed Sites o Popups dialog box.
9. Click OK on the Options dialog box.
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